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4.0  INTRODUCTION 

 

In the previous units, we have learnt the basics of computer software and the 

evolution of software. We also learnt the basic definition of Open Source 

Software. As we go further we will learn in detail this concept and how it is 

governed by the Open Source definition. 

 

In this unit, we introduce the concept of Open Source software, its philosophy and 

copyrights. We will also discuss its licensing arrangements under the Open 

Source Definition.  

 

Any computer application development comes under the umbrella of a Project 

Management process, which is supported by Project Managers. We will also 

study the role of a Project manager and his responsibilities for development of 

successful computer software. We will also see how the role and processes 

followed by a Project Manager influence the success of a project and its team. 

It is essential that we learn all the basics of Office Application software like Word 

processing, Spread sheets, emailing etc. so that we are capable of handling all 

types of roles and responsibilities when we enter the industry. 

 

 

4.1  OBJECTIVES 

 

By the end of this unit, you will know: 

 the basics fundamentals of Open Source Software; 

 the Project Management process; 

 handling of a word processing or spreadsheet file; 

 creation and modification of a database; and  

 using emails to communicate with others. 
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Open Source Software is a computer software which is available along with the 

source code and software license that permits the code to be studied, modified and 

improved. It is often developed in public and collaborative manner.  

 

The free software philosophy formulated by Richard M. Stallman in 1983, 

historically preceded the open source movement by a decade and provided some 

of the key technological, legal and ideological foundations of the open source 

movement.  

 

The best-known philosophers of the free software movement besides Richard 

Stallman are Eric Raymond, Bruce Perens, and Eben Moglen. 

 

Open source development, follows the model of the bazaar. In an open source 

development model, roles are not clearly defined. The best features and 

functionality evolve into popular use much as good ideas evolve into popular use 

in the marketplace of ideas. Development is a collaborative process, resources are 

not scarce, and no one person or organization directs the project. The users are 

treated like co-developers and so they should have access to the source code of 

the software. 

 

The Open Source Initiative (OSI) was formed in 1998 with a mission to 

harmonize the workings of the free software movement and commercial software 

development. The purpose of the OSI was to ―build bridges among different 

constituencies in the open-source community.‖  

 

The OSI is the organization responsible for certifying software licenses as open 

source licenses. Its website (www.opensource.org) gives a list of all the certified 

licenses in existence. OSI previously certified almost any license agreement that 

fit the open source definition. However, recently it announced a change in policy 

that requires any newly certified license agreement not only to fit the open source 

definition but also to be substantially different from existing certified licenses. 

This is a part of the ―nonproliferation‖ movement in open source.  

4.2.1  Introduction 

 

There are two competing definitions. The free software definition was authored 

by Richard Stallman and is more normative in nature. The open source software 

definition was authored by Eric Raymond and is more descriptive in nature. 

 

4.2.2.1  Free Software Definition  

 

The Free software definition is based on the following four freedoms: 

 

1.  The freedom to run the program, for any purpose. 

2.  The freedom to study how the program works, and adapt it to your needs. 

http://www.opensource.org/
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3.  The freedom to redistribute copies so you can help your neighbor. 

4.  The freedom to improve the program, and release your improvements to the 

public, so that the whole community benefits.  

 

4.2.2.2  Open Source Definition 

 

The other definition is the Open source definition promulgated by OSI. This 

broader definition includes permissive software licenses. The elements are: 

 Free redistribution 

 Source code available 

 Derivative works permitted 

 Integrity of the author’s source  

 No discrimination against persons or groups 

 No discrimination against fields of endeavor 

 Distribution of license with derivative works 

 License must not be specific to a product 

 License must not restrict use of other software  

 License must be Technological-natural 

4.2.2  Open Source Development Model 

 

The Open source development model is a collaborative model. It anticipates the 

participation of many developers in the development of a single product or 

module. Theoretically, any open source project can have hundreds or thousands of 

contributors. In practice, however, this is rarely the case. Most open source 

projects are relatively small, involving the work of one contributor or a small 

number of contributors. Some open source projects, such as Linux or Apache, are 

very large development projects. Nevertheless, although they may have many 

contributors, these projects have a small number of gatekeepers, or ―committers,‖ 

who decide what contributions will be checked in to the official source tree. 

 

In this sense, the model is not a pure model of the bazaar. It is more like a free 

market with a specialist’s desk. In well-known open source projects, these 

gatekeepers include some of the most respected computer scientists in the world. 

The gatekeeper decides which modifications to be included in the source tree, 

based on technical considerations, including security and stability of the code and 

compatibility with other technology, and the desires of the community at large on 

issues such as features and functionality.  

 

The most popular open source utility used by the gatekeeper is the Concurrent 

Versioning System (CVS), which is licensed under GPL. A revision control 

system allows only designated persons to check code into the source tree. It also 
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and who made the change; it further helps reconcile conflicting changes. 

 

The main features of Open Source development model are: 

 

 Users should be treated as co-developers  

The users are treated like co-developers and so they should have access to the 

source code of the software. 

  

 Early releases  

The first version of the software should be released as early as possible so as to 

increase one's chances of finding co-developers early.  

 

 Frequent integration  

Code changes should be integrated (merged into a shared code base) as often as 

possible so as to avoid the overhead of fixing a large number of bugs at the end of 

the project life cycle. Some open source projects have builds where integration is 

done automatically on a daily basis.  

 

 Several versions  

There should be at least two versions of the software. There should be a buggier 

version with more features and a more stable version with fewer features. The 

buggy version (also called the development version) is for users who want the 

immediate use of the latest features, and are willing to accept the risk of using 

code that is not yet thoroughly tested. The users can then act as co-developers, 

reporting bugs and providing bug fixes.  

 

 High modularization  

The general structure of the software should be modular allowing for parallel 

development on independent components.  

 

 Dynamic decision making structure  

There is a need for a decision making structure, whether formal or informal, that 

makes strategic decisions depending on changing user requirements and other 

factors.  

 

Most well known open source software products follow the bazaar model as 

suggested by Eric Raymond. These include projects such as the Linux kernel, 

Firefox, Apache, the GNU Compiler Collection and Perl. 

 

http://en.wikipedia.org/wiki/Continuous_integration
http://en.wikipedia.org/wiki/Continuous_integration
http://en.wikipedia.org/wiki/Continuous_integration
http://en.wikipedia.org/wiki/Linux_kernel
http://en.wikipedia.org/wiki/Firefox
http://en.wikipedia.org/wiki/Apache_HTTP_Server
http://en.wikipedia.org/wiki/GNU_Compiler_Collection
http://en.wikipedia.org/wiki/Perl
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4.2.3  Open Source Licensing  

 

License defines the rights and obligations that a licensor grants to a licensee. 

Open Source licenses grant licensees the right to copy, modify and redistribute 

source code (or content). These licenses may also impose obligations (e.g., 

modifications to the code that are distributed must be made available in source 

code form; an author attribution must be placed in a program/ documentation 

using that Open Source, etc.). 

 

All open source licenses, by definition, freely allow the licensee to exercise all of 

the rights of copyright with respect to the licensed software. Some open source 

software licenses contain explicit license grants, and some contain implicit ones.  

All open source licenses contain broad warranty disclaimers and limitations of 

liability. Most also include disclaimers of any license grant under any trademark 

of the licensor—not that any such grant would necessarily be implied in the first 

place.  

 

When an author contributes code to an Open Source project (e.g., 

Apache.org),he/she does so under an explicit license (e.g., the Apache Contributor 

License Agreement) or an implicit license (e.g., the Open Source license under 

which the project is already licensing code). Some Open Source projects do not 

take contributed code under a license, but actually require (joint) assignment of 

the author’s copyright in order to accept code contributions into the project (e.g., 

OpenOffice.org and its Joint Copyright Assignment agreement). 

 

Placing code (or content) in the public domain is a way of waiving an author’s (or 

owner’s) copyrights in that work. No license is granted, and none is needed, to 

copy, modify or redistribute a work in the public domain. 

 

Examples of free software license / open source licenses include Apache License, 

BSD license, GNU General Public License, GNU Lesser General Public License, 

MIT License, Eclipse Public License and Mozilla Public License. 

 

Check Your Progress – 1 

 

1. Give the names of a few Open Source Software applications ? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

2. What are the advantages of using Open Source Software ? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

 

http://en.wikipedia.org/wiki/Free_software_license
http://en.wikipedia.org/wiki/Apache_License
http://en.wikipedia.org/wiki/BSD_license
http://en.wikipedia.org/wiki/GNU_General_Public_License
http://en.wikipedia.org/wiki/GNU_Lesser_General_Public_License
http://en.wikipedia.org/wiki/MIT_License
http://en.wikipedia.org/wiki/Eclipse_Public_License
http://en.wikipedia.org/wiki/Mozilla_Public_License
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across geographical regions ? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

4. Give name of other industries besides software, where the concept of Open 

Source is being implemented ? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

4.3  PROJECT MANAGEMENT SOFTWARE 

 

Project management is the discipline of planning, organizing, and managing 

resources to bring about the successful completion of specific project goals and 

objectives. 

 

4.3.1  Introduction 

 

A project is a temporary endeavor, having a defined beginning and end, 

undertaken to meet particular goals and objectives, usually to bring about 

beneficial change or added value. The temporary nature of projects stands in 

contrast to other business functions which are repetitive and permanent or semi-

permanent undertaken to produce products or services.  

 

The primary challenge of project management is to achieve all of the project goals 

and objectives within the preconceived project constraints. Typical constraints are 

scope, time, and resources. The secondary—and more ambitious—challenge is to 

optimize the allocation and integration of inputs necessary to meet pre-defined 

objectives. Typical development phases of a project are: 

 

1. Project initiation stage 

2. Project planning or design stage 

3. Project implementation stage 

4. Project monitoring and controlling systems 

5. Project completion stage.  

4.3.2  Project Manager – Role and Responsibility 

 

A project manager is a professional in the field of project management. Project 

managers have the responsibility of planning, execution, and closing of any 

project. The project manager is the person accountable for accomplishing the 
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stated project objectives within the allotted time. Key project management 

responsibilities include creating clear and attainable project objectives, building 

the project requirements, and managing the triple constraint for projects, which is 

cost, time, and scope. 

 

4.3.3  Software Project Management 

 

Software project management is the art and science of planning and leading 

software projects. It is a sub-discipline of project management in which software 

projects are planned, monitored and controlled. 

 

The purpose of project planning is to identify the scope of the project, estimate 

the work involved, and create a project schedule. Project planning begins with 

requirements that define the software to be developed. The project plan is then 

developed to describe the tasks that will lead to completion. 

 

The purpose of project monitoring and control is to keep the team and 

management up to date on the project's progress. If the project deviates from the 

plan, then the project manager can take action to correct the problem. Project 

monitoring and control involves status meetings to gather status from the team. 

When changes need to be made, change control is used to keep the products up to 

date. 

 

By applying the project management cycle, one can make sure that everything 

gets done on time and that the project objectives are being achieved.  

 

4.3.4  Project Management Software 

 

Project management software covers many types of software, including 

scheduling, cost control and budget management, resource allocation, Timesheet 

management, collaboration software, communication, quality management and 

documentation or administration systems. These are used to deal with the 

complexity of large projects. 

 

The different project management activities which can be performed using the 

Project Management Software are: 

 

 Scheduling 

 

One of the most common purposes is to schedule a series of events or tasks. The 

complexity of this schedule can vary considerably depending on how the tool is 

used. Some common challenges include: 

1. Events which depend on one another in different ways  

2. Scheduling team members tasks along with the resources required by them 

commonly termed resource scheduling   

3. Dealing with uncertainties in the estimates of the duration of each task  
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In many complex schedules, there will be a critical path, or series of events which 

depend on each other, and whose durations directly determine the length of the 

whole project. Some software applications (for example, Dependency Structure 

Matrix solutions) can highlight these tasks, thus helping in optimization of effort. 

 

 Providing information 

Project planning software provides information to various stakeholders of the 

project and can be used to measure and justify the level of effort required to 

complete the project. Typical information might include: 

1. Tasks lists for team members 

2. Allocation schedules for resources  

3. Overview information on how long tasks will take to complete  

4. Early warning of any risks to the project  

5. Information on workload, for planning holidays  

6. Historical information on how projects have progressed, and in particular, 

how actual and planned performance are related  

7. Optimum utilization of available resources 

 Timesheet Management 

A good timesheet management system in place, is essential both for the customer 

projects as well as internal activities within the organization. Timesheets not only 

help the Project Manager in managing the project in a better manner but is also 

useful for maintaining employee records for payroll calculations as well as helps 

in improving the overall productivity of the organization. 

 

A timesheet is a record of the number of hours an employee spends in completing 

a certain task. This task could be associated with a customer project or with 

internal business activities. The timesheet not only provides the number of actual 

hours that the employee may have spend on the task but also mentions details of 

the task involved and the kind of operations that the task involved completing. 

Another benefit of a good timesheet management system is that it can help 

management track the efficiency of employees and find ways in which they can 

improve the productivity in various areas. Further, timesheet management 

systems can also help employees evaluate their own performances and understand 

how they can perform their tasks better. 

 

Various Timesheet management software are available like Timesheet Reporter, 

Ace Project, Time Reporting, Qtime and Time Control. Many of the Project 

Management tools also have a timesheet management module. 
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4.3.5  Tools for Project Management 

 

Project Management software tools are of three types: 

 

Desktop applications : These are software packages installed on the PC. E.g. MS 

Project, Gantt Project 

 

Web-based Services : These are websites which offer on-line internet 

applications that support project management. No separate hardware or software 

is required as the application is installed on some web server from where it is 

accessed. E.g. iTeam Work 

 

Web based Systems : These are web based software which are installed in your 

own hardware and accessed through intranet network. E.g. dot Project 

In this section, the main features of MS Project software are described: 

 

4.3.5.1  Microsoft Office Project 

 

One of the most widely used software for Project Management used all over the 

world is MS Project. It is used for planning, managing and organizing resources 

for all kinds of projects. It uses a powerful scheduling engine to help align 

different projects and tasks with available resources.  

 

Project requires all information about the overall project, the individual tasks 

needed to complete the project and the resources needed. For each task, the 

duration of task, its dependencies and constraints are also required. Once it has all 

the necessary information, it can calculate the start date and finish date for each 

task.  

 

The resources responsible for completing each task helps in Project staffing and 

management of these resources across projects.  

After project scheduling if at any point of time, the information about the project 

changes, the task and resources can be updated and the project schedule is 

adjusted. 

 

The main features of MS Project 2007 are explained below: 

 

4.3.6 Create and Schedule Project 

 

Most of the projects are scheduled based and the project start date and the finish 

date is calculated on the basis of the last task to be completed. However, there 

might be projects where the finish date is known, and there is a need to calculate 

the project start date so that it is completed on schedule date. Both kind of 

projects with known start date or known finish date can be scheduled using MS 

Project. 

1. Click the File Tab, and then click New 
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3. On the Project Tab, in the properties group, click Project Information 

 
         

4. Schedule the project in the project Information dialog box. To schedule from 

Start date, select Project Start date in the Schedule from box and then chose 

the start date. To schedule from the finish date, select the Project Finish Date 

in the Schedule from box and choose the finish date. 

 
  

4.3.7 Define File Properties for the Project 

 

1. Open the project 

2. Click on File Tab, and then click Info 

3. Choose Project Information and then Advanced Properties 

4. On the Summary tab, give the relevant project information 

 

4.3.8 Add Tasks to the Project 

 

Tasks are created to break the project work into smaller pieces. Tasks are 

activities of the project.  

 

1. On the View tab, in the Task Views group, choose Gantt chart option 
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2. In the Task Name field, type a task name. The Task IDs are automatically 

created. 

3. It is also possible to create multiple tasks using the Task Form View. To do 

this, On the View Tab, in the Split View group, select Details. The window is 

split to display the Gantt chart on the top and Task view form at the bottom. In 

the Task Form view, type the task information like Name, Duration, assigned 

resources and predecessor tasks. 

 
 

4.3.9 Create Milestones 

 

Any major event in a project is marked as a Milestone and is used to monitor the 

project’s progress. Any task with zero duration is marked as milestone. Any other 

task of any duration can also be a Milestone in the project. 

1. On the View Tab, in the Tasks View tab, click Gantt chart. 

2. Type the name of the new milestone in the Task Name field  

3. Type 0 in the Duration field of the milestone task to create the task as 

milestone 

4. To create a task with greater than zero duration as Milestone, select the task 

and then on the Task tab, choose the Task Information from the Properties 

group. Select the Mark Task as Milestone check box. In the task Information 

dialog box, click Advanced tab and then give the duration of the Milestone.  
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1. What is a Milestone in a project? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

2. What is a critical task in a project? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

3. What information can help me analyze my projects progress? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

4. What is the difference between Lead time and Lag time? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

4.4  OFFICE APPLICATIONS 

 

This section will introduce the world of office applications that are used widely 

by all of us to carry on our day to day tasks like writing a project document, 

preparing our monthly budget, corresponding with each other on email or 

scheduling our daily calendar. 

 

4.4.1  Word Processing 

 

A word processor (more formally known as document preparation system) is a 

computer application used for composition, editing, formatting and printing of 

any sort of printable material. 

 

4.4.2 Introduction 

 

Word processing was one of the earliest applications for the personal computer in 

office productivity. Although early word processors used tag-based markup for 

document formatting, most modern word processors take advantage of a graphical 

user interface providing some form of ―What You See Is What You Get‖ editing. 

Most are powerful systems consisting of one or more programs that can produce 

any arbitrary combination of images, graphics and text, the latter handled with 

type-setting capability. 
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Microsoft Word is the most widely used computer word processing system; 

Microsoft estimates over five hundred million people use the Office suite, which 

includes Word. There are also many other commercial word processing 

applications, such as WordStar, WordPerfect, which dominated the market from 

the mid-1980s to early-1990s, particularly for machines running Microsoft's MS-

DOS operating system. Open-source applications such as AbiWord, KWord, LyX 

and OpenOffice.org Writer are rapidly gaining in popularity. Online word 

processors such as Google Docs are a relatively new category. 

 

Word processing typically implies text manipulation functions that extend beyond 

a basic ability to enter and change text, such as automatic generation of: 

 

 batch mailings using a form letter template and an address database (also 

called mail merging);  

 indices of keywords and their page numbers;  

 tables of contents with section titles and their page numbers;  

 tables of figures with caption titles and their page numbers;  

 cross-referencing with section or page numbers;  

 footnote numbering;  

 Version control of a document using variables (e.g. model numbers, product 

names, etc.)  

Other word processing functions include "spell checking" (actually checks against 

wordlists), "grammar checking" (checks for what seem to be simple grammar 

errors), and a "thesaurus" function (finds words with similar or opposite 

meanings. Other common features include collaborative editing, comments and 

annotations, support for images and diagrams and internal cross-referencing. 

 

Text editors (modern examples of which include Notepad, BBEdit, Kate, Gedit), 

were the precursors of word processors. While offering facilities for composing 

and editing text, they do not format documents.  

 

Later desktop publishing programs were specifically designed to allow elaborate 

layout for publication, but often offered only limited support for editing. 

Typically, desktop publishing programs allowed users to import text that was 

written using a text editor or word processor. 

 

Almost all word processors enable users to employ styles, which are used to 

automate consistent formatting of text body, titles, subtitles, highlighted text, and 

so on. 

 

A few features of Microsoft Word 2007 are described here. 
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To add a graphic or text on the top or bottom of a document, a Header or Footer 

has to be added.  

1. Click on Insert Tab, select the Header or Footer or Page Number from Header 

& Footer group.  

2. You can select from the available gallery and choose the design required.  

3. After selection, the same design chosen will appear in the document. 

 
       

To add a customized design for the Header or Footer, double click on the Header 

or Footer area in the document. The same is opened in the design mode. After 

making the required changes to the design, close the Header/Footer area. 

 

4.4.4 Creating a Table in Word 
 

In Word, a Table can be inserted by either by choosing from a gallery of 

preformatted table templates or by using the table menu to choose the number of 

rows and columns that are required.  

 

To Choose from gallery of table templates: 

 

1. Click in the document where the table has to be inserted.  

2. On the Insert tab, in the Tables group click Table, and then choose Quick 

table. 

3. Choose the required template from the gallery displayed. 

4. The chosen table will be inserted into the document. 
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To insert a simple table with required number of row and columns: 

 

1. Click in the document where the table has to be inserted.  

2. On the Insert tab, in the Tables group click Table, and then under Insert Table, 

select the number of rows and columns required in the table. 

3. The table will be drawn on the document. 

 
      

4.4.5 Creating a Table of Contents 

 

Table of Contents (TOC) is created by applying heading styles to the text that is 

to be included in the TOC. Word will search for those headings and create the 

TOC in the document. The Table of Contents can be selected from design gallery 

provided in word.  

 

1. Select the text that is to be appear in the TOC 
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Heading2….) that you want to choose 

3. Click the place in the document where the TOC has to be inserted. 

4. ON the Reference Tab, click Table of Contents on the Table of Contents 

group 

5. Choose the TOC Style that is required 

 

 
      

In order to create a customized Table of Contents, ON the Reference Tab, click 

Table of Contents on the Table of Contents group and choose the Insert Table of 

Contents option.  

 
Here it will be possible to change the heading levels, overall look of TOC etc. 
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4.4.6 Creating a memo for multiple recipients – Mail Merge 

 

Mail merge is a software function describing the production of multiple (and 

potentially large numbers of) documents from a single template form and a 

structured data source. This helps to create personalized letters and pre-addressed 

envelopes or mailing labels for mass mailings from a word processing document 

which contains fixed text, which will be the same in each output document, and 

variables, which act as placeholders that are replaced by text from the data source. 

The data source is typically a spreadsheet or a database which has a field or 

column matching each variable in the template. When the mail merge is run, the 

word processing system creates an output document for each row in the database, 

using the fixed text exactly as it appears in the template, but substituting the data 

variables in the template with the values from the matching columns. 

 

You use mail merge when you want to create a set of documents, such as a form 

letter that is to be sent many customers or a sheet of address labels. Each letter or 

label has the same kind of information, yet the content is unique. For example, in 

letters to your customers, each letter can be personalized to address each customer 

by name. The unique information in each letter or label comes from entries in a 

data source.  

 

The mail merge process entails the following overall steps: 

 

1. Set up the main document. The main document contains the text and graphics 

that are the same for each version of the merged document. For example, the 

return address or salutation in a form letter. 

2. Connect the document to a data source. A data source is a file that contains the 

information to be merged into a document. For example, the names and 

addresses of the recipients of a letter.  
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of the main document for each item, or record, in your data file. If your data 

file is a mailing list, these items are probably recipients of your mailing. If you 

want to generate copies for only certain items in your data file, you can 

choose which items (records) to include. 

4. Add placeholders, called mail merge fields, to the document. When you 

perform the mail merge, the mail merge fields are filled with information from 

your data file. 

5. Preview and complete the merge. You can preview each copy of the document 

before you print the whole set. 

Thus, Mail Merge is used to create documents that are essentially the same but 

have a few unique data elements that vary for each document.  

 

4.5  SPREADSHEET 

 

A Spreadsheet, as you all would know, is a grid made of columns and rows 

known as cells and is used for making tables and charts used for mathematical and 

statistical analysis as well as business calculations. One of the widely used 

spreadsheet software is MS-Excel. A few features of MS Excel 2007 are 

described below. 

 

4.5.1  Introduction 

 

Each cell on a spreadsheet can have any of the following data: 

 

 Text or Labels  

 Numbers or Constants 

 Formulae which are mathematical equations to do all calculations 

Each cell is designated with a name which is actually the COLUMN Name and 

ROW NUMBER.  

E.g. A2 means the cell A21 is the intersection of column A and row 2 
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The following example shows the three basic types of data that a cell may have: 

 Labels Text which simply is the column heading like cell B2, C2, C3 etc. 

 Values which are constant  fixed numbers entries like C3, C4, D3, E4 etc 

 Formulas which are mathematical calculations as in the highlighted column 

E8. Formula cells always begin with an EQUAL SIGN (=). It is best to use the 

reference to data within the formula cells by giving the cell location. This 

helps in keeping the formula unchanged even if the values change. 

 
 

4.5.2 Basic Features 

 

The spreadsheet consists of various sheets like sheet1, sheet2, sheet3 etc. within 

the workbook. These sheets can be can be given meaningful names. New sheets 

can be inserted and worksheets can be deleted from the workbook. 

The format of the cells on the sheets can be modified using the Home->Cells-

>format->format cells option on the menu. This will give the following dialog 

box which is used to format datatype of the cell, alignment, font etc. 

 
   

The contents of the cells can be cut, copied and pasted using the Home-

>Clipboard options.  There is an option of ―Paste Special‖ (Home -> Clipboard-> 

Paste -> Paste Special) which allows only to paste certain aspects of the cells 

copied to the clipboard. 
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Values : Will paste the values of the cells on the clipboard.  If the cells copied 

contained formulas, only the results of the formulas will be pasted. 

 

 
     

 Column Widths : Will paste only the column widths of the cells that you 

copied to the clipboard. 

 Operations : This is useful if you want to scale a group of numbers or 

add/subtract a certain amount from each.  Whatever value is copied to the 

clipboard, the current operation will be done using that number on the cells in 

which you are pasting to. 

 Skip blanks : Will paste data, skipping any blank cells. 

 Transpose : Will transpose the data and paste it (columns to rows, rows to 

columns). 

 

It is possible to protect the cells so that the data cannot be changed or modified. 

By default all cells in a worksheet have the locked property turned on (the cell is 

capable of being protected).  is also possible to protect worksheet or the whole 

workbook using password protection. 

 

Protecting a Worksheet 

 

1. Click Tools, click Protection, and click Protect Sheet. 

2. Enter a password (only if desired). 

3. Confirm password (only if entered). 

4. Click OK. 
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Protecting a Workbook 

1. Click Tools, click Protection, and click Protect Workbook. 

2. Enter a password (optional). 

3. Choose to protect the Structure, Windows, or both. 

4. Click OK. 

4.5.3 Formulae and Functions 

There are different categories of functions that can be incorporated in the sheets 

like Date & Time, Mathematical, Statistical, Logical, Text functions etc. 

 
 

The different categories of functions are: 

 

Date and Time:  

MONTH - Converts a serial number to a month 

YEAR - Converts a serial number to a year 

 NOW - Returns the serial number of the current date and time 
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SUM – Adds its arguments 

MEDIAN – Returns the median of the given numbers 

SUMPROUCT – Returns the sum of the products of corresponding array 

components 

COUNTIF - Counts the number of cells within a range that meet the given criteria 

 

Text: 

CONCATENATE – Joins several text items into one text item 

RIGHT - Returns the rightmost characters from a text value 

LEN - Returns the number of characters in a text string 

 EFT - Returns the leftmost characters from a text value 

 

Logical: 

IF - Specifies a logical test to perform 

NOT - Reverses the logic of its argument 

AND - Returns TRUE if all of its arguments are TRUE 

 

Advanced Functions: 

MATCH- Looks up values in a reference or array 

INDEX - Uses an index to choose a value from a reference or array 

SEARCH - Finds one text value within another (not case-sensitive) 

REPLACE - Replaces characters within text 

 

Database Functions: 

DGET- Extracts from a database a single record that matches the specified criteria 

DCOUNT - Counts the cells that contain numbers in a database 

DSUM - Adds the numbers in the field column of records in the database that 

match the criteria 

DPRODUCT - Multiplies the values in a particular field of records that match the 

criteria in a database 

 

Lookup & Reference:  

VLOOKUP - Looks in the first column of an array and moves across the row to 

return the value of a cell 

HLOOKUP - Looks in the top row of an array and returns the value of the 

indicated cell 

INDIRECT - Returns a reference indicated by a text value 
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4.5.4 Charting 

Charts and Graphs can be created based on data in the sheets. To create a chart to 

represent data graphically: 

1. Select the data 

2. Go to Insert 

3. Select the chart type from the options available like Bar, Line, Pie, Scatter etc. 

4. The chart will get automatically populated with the selected data on which the 

chart is to be based. 

 
 

4.5.5 Macros 

 

A macro is a short program written using VBA that can be used to carry out a 

specific task. VBA is the language that Excel macros are written in.  It is a 

programming language that is included with all of the Microsoft Office 

applications e.g. Word, Access, Power Point, Excel as well as others.  

VBA is a subset of Microsoft Visual Basic, an extremely popular programming 

language that has been around for over 10 years. The Macro has to be recorded as 

follows: 

1. Go to the Tools menu, go to ―macro‖ and then ―Record New Macro‖ 

2. Assign a name to your macro if you'd like, as well as type a short description. 

3. You can also assign a keyboard shortcut to it (so you can press a sequence of 

keys to run the macro). 

4. Now click on OK. You'll be returned to Excel. 

5. Simply perform the actions you want the macro to do. 

6. Once you're done recording your macro, press the Stop button which should 

now be visible on your screen. 
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1. Run a macro by using the menu command 

2. By pressing a CTRL combination shortcut key 

3. Clicking a toolbar button or an area on an object, graphic, or control 

4. Run a macro automatically when the workbook is opened. 

4.5.6 A Small Example in Excel 2007 

 

Take a small example given in the table below for calculation of Salary and 

Income tax deduction and compute the result in excel to give the net monthly and 

annual income as shown below: 

 

Income Head Amount per month 

Gross Income 100000 

Tax percentage 10% 

Tax Deduction Gross * Tax Percentage 

Net Income Gross – Tax Deduction 

Annual Income Net Income * 12 

 

After calculation and writing the formulas in Excel 2007, we would get the 

following results: 

 

 
 

4.6  DATABASE 

 

Database is used to organize information into data in the form of tables. For 

example, a table with student’s data. Different tables are joined together on the 

basis of relationships. The table and relationships together form relational 

structure. Relational Structure helps in reduction of repetitive data, improves 

accuracy and provides better management of data. 
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4.6.1 Introduction 

 

A Table is a database object that is used to store data about a particular subject 

like employees, students or products. In a Table, the columns are called fields or 

attributes and the individual records are called Tuples (rows). One of the most 

important advantage of a Relational table structure is the Primary key field in 

each table. A Primary key is a field or a combination of fields that make each 

record in the table unique. Primary keys help in removing duplicate data and 

creating relationships between different tables. Foreign Key contains values that 

correspond to the primary key of another table. A table can have one or more than 

one foreign key. 

 

Every field has a datatype which indicates the type of data that filed will stores, 

such as text, numbers or external files.   

 

The most commonly used database in the industry is MS-Access. Here, we will 

see how to manage a simple database in MS-Access. 

 

4.6.2 Create Table in Database 

 

1. Click the Microsoft Office Button, and then click New. 

2. In the File Name box, type a file name for the new database. 

3. To browse to a different location to save the database, click the folder icon. 

4. Click Create. 

The new database opens, and a new table named Table1 is created and opens in 

Datasheet view. When you create a new table in Datasheet view, Access 

automatically creates a primary key for you and assigns it a field name of ID and 

the AutoNumber data type. 
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In order to add new fields to the Table, enter into Design view, On the Home tab, 

in the Views group, click View, and then click Design View. Here add the fields 

and set their properties like datatype, size, default value, input mask etc. The field 

which has to be made primary key is also set here.  

 

 
     

When you create a new table in Datasheet view, Access automatically creates a 

primary key for you and assigns it a field name of ID and the AutoNumber data 

type. In Design view, you can change or remove the primary key, or set the 

primary key for a table that doesn't already have one. 

 

After the table is created, it is saved in the database by going to Microsoft office 

button and choosing the Save option.  

 

4.6.4 Add Data in the Table 

 

Once the Tables have been created, data has to be added to them.   

1. Open the database to which data has to be added.  

2. Select the table to which has to be inserted 

3. The table opens in the datasheet view mode.  

4. Add the data to the table record by record in the datasheet grid and save the 

table. 

The data added can also be modified also in the datasheet view mode. 
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4.6.5 Add New Fields in the Table 

 

To add new fields to the table, open the table in design view mode.  

 

1. In the Home tab, in the Views group, click View, and then click Design View. 

2. In the table design grid, add the new field  

3. Define its properties like datatype, length, default value etc. 

4. Save the changes made to the table 

 
    

4.6.6 Set a Table’s Primary Key 

 

When a new table is created, Access automatically creates a primary key and 

gives a default field name ID and AutoNumber as its datatype. In Design view 

mode, it is possible to change, remove or set the primary key of a Table. 
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2. On the Home tab, in the Views group, click view and then select the Design 

view mode. 

3. In the Design grid, select the field or fields (by holding down CTRL to select 

more than one field. 

4. On the Design tab, in the Tools group, click Primary Key. A key indicator 

appears on the left of the field or fields selected to indicate the field as 

primary key. 

 
       

4.6.7 Defining Relationships 

 

When you create a relationship between tables, the common fields are not 

required to have the same names, although it is often the case that they do. But, 

the common fields must have the same data type. If the primary key field is an 

AutoNumber field, however, the foreign key field can also be a Number field if 

the FieldSize property of both fields is the same. For example, you can match an 

AutoNumber field and a Number field if the FieldSize property of both fields is 

Long Integer. When both common fields are Number fields, they must have the 

same FieldSize property setting. 

 

To create relationships between two tables,  

 

1. Choose Relationships under the Database Tools menu. 

2. Then Choose the Table option and add the tables between which relationship 

has to be created. 
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3. Drag a field (typically the primary key) from one table to the common field 

(the foreign key) in the other table. To drag multiple fields, press the CTRL 

key, click each field, and then drag them. 

4. The Edit Relationships dialog box appears as below: 

 
    

5. To enforce referential integrity for this relationship, select the Enforce 

Referential Integrity check box. 

6. Click Create. 

Access draws a relationship line between the two tables. If the Enforce 

Referential Integrity check box is selected, the line appears thicker at each end. In 

addition,  the number 1 appears over the thick portion on one side of the 

relationship line, and the infinity symbol (∞) appears over the thick portion on the 

on the other side of the line, as shown in the following screen. 



 

111  

Computer  Applications 

 
         

The purpose of referential integrity is to prevent orphan records and to keep 

references synchronized. Once referential integrity is enforced, Access rejects any 

operation that would violate referential integrity for that table relationship. This 

means that Access will reject both updates that change the target of a reference 

and deletions that remove the target of a reference. To propagate the referential 

updates and deletions so that all related rows are changed accordingly, see the Set 

the cascade options section. 

 

4.6.8 Defining Queries 

 

When data has to be reviewed, added, changed or deleted from the database, a 

query is used. Queries are also used to answer very specific questions about the 

data that would be difficult to answer directly by just looking at the table data. 

Queries can be used to perform calculations on the data, to filter data and to 

summarize the data.   

 

1. On the Create tab, in the query group, click query design. A show Table 

dialog box appears. 

2. In the Show Table dialog box, choose the table on which query has to be 

based and close the show Table dialog box.  
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3. In the selected Table, double click the fields that have to be added to the query 

4. On the Design Tab, in the Results group, click Run. 

 
     

The query will be executed and the result is displayed in the grid as shown below. 
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A Report consists of information from tables and queries that is stored with a 

particular report design such as labels, headings and graphics. 

 

1. In the Navigation pane, select the query or Table on which the report has to be 

based. 

2. On the Create Tab, in the Reports group, click Report 

3. The Report will be created and displayed 

 
 

Once the report is created, its layout can be modified in the Report design view. 

Reports can be created using the Report wizard tool also.  

4.6.9.1  A Small Example in Access 2007 

We wil create a small database for employees in an organization using MS Access 

2007. Make two tables T_Employee_dtls and T_Dept_master database tables with 

the following structure: 

T_Employee_Dtls 

Field Name Datatype 

Emp_code Autonumber 

Emp_Age Number 

Dept_code Text 

Emp_Address Text 

 

T_Dept_master 

Field Name Datatype 

Dept_code Text 

Dept_Name Text 

Define Emp_Code and Dept_code as the Primary keys for the table 

T_Employee_dtls and T_dept_master respectively. Then define the relationship 
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between the two tables  as explained above in section 5.3.7. Add data to the table 

and then define the following queries as explained above: 

SELECT T_Employee_dtls.Emp_Name, T_Employee_dtls.Emp_Address 

FROM T_Employee_dtls; 

SELECT T_Employee_dtls.Emp_Name, T_Employee_dtls.Emp_Age, 

T_Dept_Master.Dept_Name 

FROM T_Dept_Master INNER JOIN T_Employee_dtls ON 

T_Dept_Master.Dept_Code = T_Employee_dtls.Dept_Code; 

Reports can be generated based on these queries or different queries can be 

written to generate various reports. 

 

4.7  E-MAIL 

 

Emailing is one of the most important utilities in today’s world. It is used widely 

and utilized by almost each and every one of us not only as professionals but also 

in our personal lives. Emailing software like MS Outlook , Outlook Express etc, 

not only provides emailing facility but also used for scheduling appointments, 

maintaining contacts, setting task reminders, sending attachments with emails etc. 

 

4.7.1 Introduction 

 

Email Accounts can be from the Internet Service provider, employer, or webmail 

services like yahoo, Gmail etc. Outlook doesn’t have its own accounts but uses 

these email accounts. Outlook uses POP configuration to access the web based 

servers for emails. Post Office Protocol (POP) is an application-layer Internet 

standard protocol used by local e-mail clients to retrieve e-mail from a remote 

server over a TCP/IP connection. 

 

POP supports simple download-and-delete requirements for access to remote 

mailboxes. Although most POP clients have an option to leave mail on server 

after download, e-mail clients using POP generally connect, retrieve all messages, 

store them on the user's PC as new messages, delete them from the server, and 

then disconnect.  

 

To send or receive email messages with Microsoft Outlook, these email account 

information has to be added. Email Accounts are contained in profiles. An email 

profile consists of email accounts, data files and settings as to where the emails 

are to be stored. There can be one profile or more than one profile depending on 

the requirement of the user. There can be one or more email accounts within a 

single outlook profile. 
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Before using Outlook, an Email profile and account has to be created. 

 

1. In MS Windows, go to control panel and select Mail option. 

 
 

2. Click Show Profiles 

3. Click on Add and Type a name for the profile and then click OK 

 

4. Add email account to use in your profile by following the directions on the 

screen. 

4.7.3  Create a new Email Message 

 

The most important feature of Email software is to send and receive emails. Once 

the email account has been configured, the same can be used to send and receive 

emails. 

1. On the File menu, select, New ->Mail Message 

2. In the Subject box, type the subject. 

3. Add the recipient’s name in the To, CC, Bcc box. Separate the names with 

semicolon. 
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4. To select the recipient’s name from a address book, click the To or CC button 

5. The level of importance for message can also be set which appears as an 

indicator by selecting High Importance or Low Importance in the Options 

group in the message tab. This is only an informational flag and does not 

expedite or affect actual message delivery. 

 
     

It is also possible to put file attachments along with the email message or include 

website links or links to documents present on a shared network. 

 

4.7.4 Manage Contacts 

 

New Contacts can be added to the Address Book. It is possible to make groups of 

Contacts and create distribution lists to ease selection of contacts when sending 

messages. 

 

1. To add a new Contact, select File Menu, New->Contact 

2. Fill in the Contact Details on the contact form that appears. 
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1. Open or preview the email message that contains the Contact name that is to 

be added to the Contact List 

2. Right Click the name of the sender and then Click Add to Contacts through 

the shortcut menu. 

 

4.7.5 Calendar Management 

 

Using the Calendar feature, one can schedule activities as appointments, 

meetings, events or tasks. This choice will depend on who is involved and how 

the entry should appear. 

 

To view the activities of any day, click on Calendar in the Navigation Pane. And 

then choose the date for which the activities need to be shown. 

 

 
It is possible to view the activities, day wise, month wise or week wise as 

required. 

 

Right Click on the time and date the activity has to be set and choose the activity 

type whether it will be an appointment, meeting or event or task. 

 

A meeting occurs only at a schedules time and includes other people and a 

meeting location. An Appointment is an activity where only one person is 

involved. A task is an entry that is seen in the calendar but doesn’t need to be 

scheduled for a specific time. An event is an activity that lasts all day and do not 

occupy schedule time in the calendar but appear as banners on the top of the date 

specified for the event like conferences, business travels, holidays etc. 
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If any particular activity is occurring again and again, it can be set as a Recurring 

activity using the Recurrence feature. To set up a recurrence pattern, open the 

appointment and click Recurrence button in the Options group in the 

Appointment tab. 

 

Check Your Progress  3 

 

1. Is it possible to import data from Excel into Access? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

2. What is a signature of an email message? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

3. Is it possible to get a delivery receipt from the email recipient? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

4. Which of the following entry will be best entered as an event in your 

calendar? 

…………………………………………………………………………………

…………………………………………………………………………………

………………………………………………………………………………….. 

 A party that occurs from 4 pm to 6 pm 

 Birthday 

 A visit to the dentist 
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In this unit, you have learnt about the concepts of Open Source Software. The 

history and philosophy behind this concept has briefly been described. The 

Licensing and copyright issues have been discussed. This is an upcoming concept 

in the industry and the idea of open source software is here to stay. 

 

You have also been introduced to one of the most important roles of Project 

management which is essential for the success of any project. The different kinds 

of software which are used for project management of resources, time and scope 

of project have been discussed. 

 

The essential tools of Office Applications which are used widely in the industry 

have been discussed. After reading this unit, you must have become familiar with 

the important features of these tools used for word processing, database 

management and emailing.   

 

4.9  ANSWERS TO CHECK YOUR PROGRESS 

 

Check Your Progress  1 

 

1. List of a few Open Source software applications are: 

 Web Browsing – Mozilla Firefox 

 Instant Messaging – Pidgin 

 Operating System – GNU/Linux 

 Email – Mozilla Thunderbird 

 Word Processing – OpenOffice.org 

 Graphics – Paint.NET 

 FTP - Filezilla 

2.  The advantages of using Open Source Software are: 

 The core software being free, using open source software reduces the total 

ownership cost for any organization 

 As new changes and evoluion is a constant process for Open Source 

Software, new upgraded versions of the software are available. 

 The organization doesn’t have to be dependent on any particular vendor as 

in case of commercial software for support and assistants. Help is easily 

available on the internet for troubleshooting 

 If necessary ,it is easier to customize and make modifications in  the 

source code for Open Source Software  
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3. Revision control systems such as Concurrent Versions System (CVS) are used 

to track and centrally manage the source code files and changes made in the 

open source software. 

 

4. The different industries where Open Source concept is being practiced are: 

 

Electronics: Open Source Hardware where the initial specifications are 

published and made available so that the hardware and the source code can 

redistributed without paying royalty or fees E.g.: SUN Microsystems’s 

OpenSPARC T1 Multicore Processor. 

 

Beverages: Here the recipe is open source unlike other corporations 

producing beverages where the recipe is a closely guarded secret. E.g.: 

OpenCola 

 

Digital Content: Sites such as Wikipedia and Wiktionary where the content 

remains free to re-use and the source documents are readily made available to 

those interested and changes are accepted back into the system. 

Robotics: Here the blueprints, schematics and source code are released under 

the open source model.   

 

Check Your Progress  2 

 

1. A milestone is a reference point that marks a major event in a project and is 

used to monitor the project's progress. Any task with zero duration is 

automatically displayed as a milestone. You can also mark any other task of 

any duration as a milestone. 

 

 

2. Tasks which cannot be delayed without affecting the project finish date are the 

critical tasks. A Critical must be completed on schedule for the project to 

finish on time. If a critical task is delayed, the project completion date might 

also be delayed. A series of critical tasks makes up a project's critical path. 

 

3. Five pieces of task information help to analyze the project progress: 

 Duration 

 Work  

 Start date 

 Finish date 

 Cost 

Variations of each of these types of fields help you compare and evaluate your 

progress. 
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Lag time: A delay between tasks that have a dependency. For example, if you 

need a two-day delay between the finish of one task and the start of another, 

you can establish a finish-to-start dependency and specify a two-day lag time 

 

Check Your Progress 3 

 

1. Yes, it is possible to import data from Excel workbook into Access 2010. This 

can be done by copying data from an open worksheet and pasting into Access 

datasheet, or by importing a worksheet into a new or existing table, or linking 

the worksheet from an access database. 

 

2. Signature is the way the senders name will appear at the end of the message. 

One can create a default signature to be added to all your outgoing messages, 

or you can insert a signature manually into outgoing messages on an 

individual basis.  

 

3. A delivery receipt tells you that your e-mail message was delivered to the 

recipient's mailbox, but not whether the recipient has seen it or read it.            

A read receipt tells you that your message has been opened. In both cases, you 

receive a message notification when your message is delivered or read. The 

contents of the message notifications are then automatically recorded in the 

original message in your Sent Items folder. 

 

4. Birthday’s happens all day long, and that's what an event is used to enter. The 

benefit of using an event is that you can show the event at the top of that day 

in the calendar. You'll remember, and the time in your calendar is still 

available for you to schedule. 
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